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Web Standards are a group of rules folks have agreed upon as the “way” to markup pages for
delivery through the Web. The organization that codifies these rules is the World Wide Web
Consortium (W3C), and its director is Tim Berners-Lee, the creator of the Web. The consortium
is made up of a large group of individuals, including those representing major technology
corporations, such as Microsoft, Apple, Adobe, and Macromedia (the full list is online at:

http://www.w3c.org/Consortium/Member/List). Among the two most important standards that

we read about today are the markup languages XHTML and CSS.

XHTML is the successor to HTML, and the letters stand for eXtensible Hyper Text Markup
Language. With attention cornered on the novelty of “X” themed gear, such as X-Box. X-Men and
Mac OS X, the “X” certainly adds interest to boring old HTML. The syntax of XHTML is
slightly different from its little brother, and follows syntax rules belonging to XML, the eXtensible
Markup Language. Knowing simply that XML is a powerful markup language on its own, and that
XHTML is a subset of this, promises that well-coded XHTML will last the test of time.

One of the things the W3C did was to remove presentational markup from HTML, when
codifying XHTML. This eliminates tags such as FON'T, BGCOLOR, and discourages the use of
spacer GIFs, &nbsp; spaces, and the like. Instead, the W3C recommends the use of Cascading Style
Sheets (CSS) to change the presentational appearance of content on the web. Because CSS is
separate from the structural format of your documents, the content can be presented on a variety of
media, even on devices that do not understand CSS. When XHTML is combined with CSS, you
have the opportunity to share your content with as wide an audience as possible, using browsing
devices other than a PC. CSS also allows you to present your material in different guises, to offer,

for instance, different backgrounds, color schemes, and font sizes.



Using web-standards is in large part also helpful for creating accessible web sites. Many folks who
browse the web have disabilities, which range from a lack of a full range of motor skills (for
manipulating the keyboard or mouse), to vision, and hearing. Pages that follow web-standards can
be easily modified, if need be, to meet government-sanctioned requirements, along with those

presented by the W3C, for accessibility (http://www.section508.gov/).

There are a variety of tools you can use to generate web sites, and many of them will allow you to
effortlessly do so using Web Standards. Needless to say, no product will automatically do this for
you; it takes knowledge of the standards to make sure the tools follow your desires for standards-
compliance. This guide will cover two of the most popular tools available: Adobe Photoshop for
graphics, and Macromedia Dreamweaver, for XHTML and CSS. The versions covered for this
guide are Photoshop 7 and Dreamweaver MX. Screen-shots are from the Macintosh (OS X)

versions of these cross-platform applications.

The differences between HTML 4.0 Strict, another web standard, and XHTML 1.0, are few. The
following are a few tips to produce good XHTML markup. There will be exceptions to these tips
and an extensive text on XHTML will be your best guide. I highly recommend HTML &
XHTML, the Complete Reference, by Thomas A. Powell, and published by Osborne Complete

Reference Series.

All markup is in lowercase

All tags close, even single tags such as <br />

Presentational tags and attributes are out (bgcolor=, vlink=, <FONT>)

The document opens with a <!DOCTYPE> tag (which incidentally, breaks rule #1)

A tag declaring character encoding is included (telling which set of characters you're using)
All attributes use quotation marks around values (title="Visit our Store”)

You use the alt= attribute with the <img> tag, to give context for the image in lieu of

displaying the image

If you put Dreamweaver into XHTML mode, it does a fair job at providing help with many of
these rules. You can force it to include a <IDOCTYPE>, add quotes around attributes, and make
it bug you for ALT's in your IMG tags. Your ultimate help, however, will come from the W3C
validator, a server-based application that checks your web page for standards-based compliance

(http://validator.w3c.org/).




The following code, borrowed from the Goochland County Public Schools website, demonstrates

what the <HEAD> of an XHTML document might look like:

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtmll-transitional.dtd">
<html xmlns="http://www.w3.0rg/1999/xhtml">
<head>
<title>Goochland County Public Schools Homepage</title>

Notice in the <IDOCTYPE> I've indicated the “flavor” of XHTML I'm writing in: XHTML 1.0
transitional. This means I can break a few rules, and still get-by with using XHTML. One
drawback in the Goochland site was the use of a <TABLE> for presentation. A table-less version
had first been created, relying upon CSS, but failed to work in every browser. Using a hybrid
solution aided in the support we could offer to families using a wide-variety of browsers. More

<IDOCTYPE> tags can be found online at:

http://www.webstandards.org/learn/templates/index.html. Compare the features supported by

different browsers at WebMonkey:

http://hotwired.lycos.com/webmonkey/reference/browser_chart/.

If you're familiar with HTML, you might find this article a good place to start, which compares
XHTML and HTML, and what they have in common:

http://www.webstandards.org/learn/reference/common ideas.html
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From Dreamweaver, we have the New Document... dialog box. While you can build your own
templates, with any such starter markup you choose, notice here we have chosen an HTML page,

and have checked the “Make Document XHTML compliant” option.

You can also have Dreamweaver try to convert documents you already have created in HTML, to

XHTML:

r hl

It appears that you document is not an XML
document

@ because it is missing the required <?xml...?> tag.
You can use Dreamweaver MX to convert your HTML
documents to XHTML by selecting Convert -> XHTML

from the File menu.

If you want the document converte

-'Cancel'-(_ OK \j

The code I start with, after choosing an XHTML Strict definition, is:

<?xml version="1.0" encoding="is0-8859-1"7>

<!IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Strict//EN"
"http://www.w3.0rg/TR/xhtml1/DTD/xhtmll-strict.dtd">

<html xmlns="http://www.w3.0rg/1999/xhtml">

<head>

<title>Untitled Document</title>

<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1"

/>

</head>

<body>

</body>
</html>

My recommendation at this point is to remove the first line, declaring which version of XML is
used. Why? Some browsers cough on it, and it may give you problems. It's in the specification for

XHTML, but not required for version 1.0.

Notice the <XMETA> tag closes by using a space, then />. Other tags this affects are <br />, and

<hr />



One thing you'll notice when looking at pages coded in XHTML (and I do mean here, looking at
the code), is that they seem very clean, and perhaps even simple. This is because most pages have a
straightforward structure: headings, paragraphs, and some with sections (<DIV>). All the code for
presentational markup is either embedded in the <HEAD> section using CSS, or neatly tucked-
away in an external style sheet. While many designers think of creating pages with a visual
emphasis, it is always refreshing to think about your page in terms of text flow, and the focus upon
the quality of writing. Simple, clean markup then usually follows. For tips on writing for the web, I
highly recommend Hot Text: Web Writing that Works by Jonathan and Lisa Price, and published by
New Riders.

Cascading Style Sheet language books again might be a good, all-around reference if you want to
learn all CSS can do, and none are better than those authored by Eric Meyer

(http://www.meyerweb.com/). For some reason, there are a lot of sites dedicated to CSS

information, and you might be just as happy consulting the Web, plus it’s free.

CSS has three main ways to make style definitions:

* bytag
* byclass
* byID

CSS also includes three different types of style sheets:

* inline

® internal

* external
The diagram following this section tries to sum-up a lot of information about CSS in a small space.
If you want to know CSS inside and out, this diagram will probably appeal to you—or use it as a
reference. The “cascade” in CSS means that the rules you apply to how something looks (say a

background, or the font size of your paragraphs) can “cascade” off one another if they are defined

differently. For instance, let’s take a look at the following definitions:

p {font-size: 15px; color: #000; }
p.important {font-size: 20px;}
p#first {font-size: 15px; color: #333;}
The first definition says: Size all paragraphs with a font with an x-height of 15 pixels, and make the

color of the text black. The second says: for paragraphs of the class “important”, change the font-

size to be 20 pixels, and keep the black color. And, the third: make the paragraph with the ID



“first” dark gray, and we'll keep the 15 pixel size. My question to you is: What would a paragraph,
defined as such, look like?

<p class="important” id="first”>This is my first paragraph.</p>

Types of Stylesheets

>

External (.css)

Internal (<style>)

A Inline (style attribute)

| Great when you want all your pages to look the same |

N

| Style is separated from content, but still within the same document ]

Cascading Style Sheet Language
css Three Types of Definitions

The Cascade

| Some Common Things to Define |

font-family

>| for specific instances, added alongside the content with the tag |

‘1 defined by the "class =" attribute in a tag |

! defined by the "id=" attribute in a tag |

4(>| Style sheets "cascade" off one other, based upon hierarchy. Which style definition has more "power" or control?

4|>| external sheet < internal definitions < inline definitions
L pftag <class <id

etter-spacing

—
font-variant The Rules

p {font-family: Times, "Times New Roman", Palatino; font-size: 14px;}
<p style="text-decoration: underline; color: #f00">This is my paragraph</p>

border-style

border-width

text-decoration [

background-image |
background-color [

1. In internal and external definitions, use the curly brackets {} to place the definitions
2. In inline definitions, list the attributes within the quotation marks of the HTML Style attribute
3. Style definitions should be lower case, one word, or multiple words with a hyphen, never spaces
4. For font names that have spaces, use quotation marks
5. For numbers, you can use several units of measurement (px, in, cm, em, pt, %) but always indicate the
unit being used. Prefer to use pixels over points for font-size

background-attachment [
background-repeat [ 6. You can indicate class or id instances such as this:
div > #side {margin-left: 15 px;}

Copyright ©2003 John G. Hendron 7. Indicate the end of a definition with a semicolon
All Rights Reserved

According to the rules, it would have dark gray text and a 15-point x-height in size. Why?
According the diagram, a rule that's defined with an ID overrides class, and in this case, the class

definition gets overruled!

If you're new to CSS, keep in mind: you only have one “ID”, typically, in your page. It's a unique
object, and you can ID just about any tag... an image, an <H2>, or whatever you like. Classes are
the same way, but are not unique. And the names you assign both classes and IDs can be anything
you like, save for reserved words. You cannot use the same identifiers, either (you wouldn't create a

class called “X2” and an ID called “X2."). Don'’t try to confuse your web-standards browser.

Thankfully, Dreamweaver has a CSS editor that makes remembering all the different types of CSS

definitions a snap. It won't allow you to create every type of valid CSS definition, but... for most



pages and sites, it’s a lot quicker than hand-coding every definition from scratch. Clicking on the

panel menu in Dreamweaver, you can see many of the options available with its CSS editor:
=2 ) al
" W Design i= L
[3ress Styles | AAHTML Styles | &} Behaviors | Edit...

) Apply Styles (%) Edit Styles |

no styles define |

Use External Editor

New C5S Style...
Edit Style Sheet...
Attach Style Sheet...
Export Style Sheet...

Help

Croup C55 Styles with >
Rename Panel Group...
Maximize Panel Group

Close Panel Group

———
types of CSS
... for most
A2 1.

The most important part is the “Apply” and “Edit” radio buttons. Most times, I keep it in “Edit”
styles. Use “Apply” when you want to apply both IDs and Classes to items in your page. It then
makes it easy to apply a certain class to a number of items that would be laborious to do in code
view, such as changing the “class” of “Days” in a calendar to reflect the same color. (One example, is
our January lunch menu, at our web site:

hetp://www.glnd k12.va.us/calendars/january2004menu.html .)

New CSS Style

Tag: body @ (7&( }

Type: () Make Custom Style (class) [ Cancel )

%) Redefine HTML Tag
:; Use CSS Selector

Define In: () | (New Style Sheet ... T]

f*) This Document Only ( Help )

I usually start my style sheet by defining the BODY tag, so that I can choose a background, and a

font size and selection that will apply to the entire page.



I then proceed and make as many definitions as I like, for the <BODY> tag for the first category,

UT ”
YPC :
r . el hl
CSS Style definition for body
Category Type
Type R .
Background Font:  Syntax, TradeGothic, Lucida Grande, Arial, sans-serif E]
Block e 5 - - - .
Box Size: 14 E] pixels % ] Weight: E]
Border r "
List Style:  normal E] Variant: E]
Positioning ) ) r . — . B
Extensions Line Height: E] v Case: @
Decoration: : underline Color: l_' HCCCCCC
: overline
"l line-through
I blink
@ none
p—Help— | Apply )| Cancel | ( OK )

Things can get dangerous, as I navigate through the categories, if I don't know what's going on.
Sadly, the further down you dig, Dreamweaver has an increasingly hard time at rendering your
CSS in its Design View mode. Therefore, frequent trips to your favorite web-standards-compliant
browser are commonplace. Dreamweaver MX 2003 reportedly has much better CSS support, and

better rendering thanks to an Opera-based rendering engine.

Soon enough, I can begin adding content:

aXaXa) My New CSS Document (Untitled-1%) (XHTML) (=]
B 22 & =5 Title: "My New CSS Document | I '@, < E,
T

150

¥ Design
(T)CSS Styles {AHTML Styles | &3 Behaviors |
: Apply Styles @ Edit Styles

#CCCCCC none font: normal 14px Syntax, TradeGothic, "L

My CSS information is summarized in the CSS panel. By double-clicking the definition, I can

make changes. Just make sure “Edit Styles” has the circle selected.



When going the web-standards route, be sure and avoid using, at all costs, the Properties Pane in

Dreamweaver for manipulating fonts:

Format MNone -:!_.;;Qg Default Font Size Mone E @
Link @7  Targe

P
e

ak

Thankfully, it does still come in handy for adding links, choosing B and I for the <STRONG> and
<EM> tags, and creating lists <UL> and <OL>.

Visual appeal is important on the web, and your school’s site should have some! Photoshop, and its
companion, Image Ready, are excellent tools for web design. You can begin the design process with

these applications, or, simply use them to prepare graphics for your web-standards-compliant site.

One simple use of Photoshop is to create a background image for your website. The background
can be a pattern, or a single image that stays-put in one corner of your page. Knowing the
hexadecimal code for your main color is helpful when designing graphics with transparency to

appear over your background—this would be your matte color.

I won't say a lot about patterns, simply because they're typically seen as a cliché for bad designs
from, say, around 1998. It was the next step, evolution-wise, from the plain-color background.
Photoshop, and ImageReady, have two tools that can be used to create a custom, seamless pattern,

if you just can't stay away.

Using Photoshop, we start with a

Phow]shop File Edit Image Layer Select Filter View Window Help ‘
. . . . el | v Height: Resolution: pies/ich [§)| ( Frontimage ) (R ) [earerre e s
picture... this is from my holiday dessert Gl : W o SO

making, and brings back sweet memories.

While the size of this photo (900x661) is

far too large for most applications on the

3
00K (] 300phels x 651 pixels



web, I can use it to develop some interesting patterns.

Under Filter, Choose Pattern Maker. Next up, is a new screen that allows you to generate, using

some random variables, a pattern based on the photograph you've chosen. In my case, it's chocolate.

Choose the Generate (or Generate Again, after your first attempt) to see o
what Photoshop comes up with. ( cancel )
( Generate Again b

— Tile Generation
2 Uze Clpboard as Sample

Notice you can change the width and height of your tiled piece. The (e image 5

W idth (222 :!
Height | 200 :!
tool works best with things that are already patterns: flowers, grass, offset (Mone 5

R

picture used above didn't result in a very interesting pattern for me. This "
pi

Armount S0

clouds, etc., by reducing the size required to fill the space. Using a scene ——— j

of trees, I came up with a tile that still expressed the feeling of nature, sunpkoetal [ [Bex

borrowing the same sample of colors from the original:

re 06 | treescened.tif @ 33.3% (Layer 0, RGB#)
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33.33% |0 | 1501 plels x 1949 pixels 3 Y

The other Tile-maker is only found in Image Ready. To switch progrlalms, locate the “Jump To”
button at the bottom of your toolbar, and open Photoshop’s companion

program:




Within ImageReady, choose the TileMaker filter. I am choosing mw”e"’?

the default settings for now, and let’s see what appears: — onx |

F =] Artistic

Tile Maker Blur

Brush Strokes
Distort

© Blend Edges ok ) e
Sharpen

Width: 10 percent P — Sketch
| Ca H'CEI _/I Stylize

L% Texture

W Resize Tile to Fill Image —— Video

Comer T
- i 5 "
_ Kaleidoscope Tile Digimare > __T"e pker—

The result is a document, the size of my original, that will “blend-in” at the edges, and when

YTYVYVYVVYVYVYVYVYYY

repeated as a web background, will appear “seamless.” In this way, you can use a small image (say

200x150 pixels) and enjoy the cost-savings for bandwidth, yet fill up an entire screen.

If my image was named tile.jpg, the CSS code would look like this:

body { background: #006 url(tile.jpg) repeat; }
Let’s deconstruct! The background notation is shorthand CSS, and can be used to combine
several definitions. Here, first, I define a background color of dark blue, then I also indicate I want
to use a background image, which will repeat. Just leave spaces between each part. For an

explanation of RGB and hexadecimal color, visit http://www.wurd.com/pwp _color.php.
P I PWE pht

For our next background, let’s try to combine several more advanced-Photoshop skills to create a
background that makes use of transparency plus a static background color. The first step is to
choose a photograph, and one of the author magically showed up:

‘800 I John_blue.jpg @ 33.3% (RGB#)
o 200 [f00 [i500 [1500 K

00 [P0 [s00 [s00 |s00 |00 [0 [s00 [Bo0 [1000 [1100 16001700 [1500 [1500 2000 [2100 2200 (2500 [2400 2500 [2600 [2700 [2800 [2900 [500C

3072 piels ¢ 1200 pixels 4



Our task is to cut out my image away from the background, and set it against a blue-ish

background for the web page. First things first!

Our first step is to choose how to cut me out. Common choices include: the Freeform Magnetic
Pen Tool, the QuickMask mode, or perhaps... Extract. I am going to use Extract for this

demonstration. Choose Filter > Extract.

After tracing with the pen, and filling with the bucket, yours truly is ready for extraction:

Extract

[ ok Previn o sethe image it the backaround removec o DK to extr ot and xR inmeditely o)
a (" cancel )
mGance™
7 (preview )
i
- Toot Optons
Hanignt (Green— T8)
-i"i I ——)
() Smart Wity
- Bractin
smoth 12 8
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ey (Hore
) show Hopiat

svov e

After some re-sizing, I was about ready to

r

Image Size
move into the virtual world of the Web. el Dimensions. 210K (was 15.8%)
Make sure now, that you're working with an width: [350 | (pixels = ]]@ € Cancel D
. .. . Height: |205 ( pixels B3 —_—
image at 72 PPL. This is web resolution, and ght: | | ( Auto.. )

— Document Size:
Width: [4.861 | Cinches 9

72, Height: [2.848 | Clinches = ]@

Resolution: |?2 | pixels/inch l:]

@ Constrain Proportions

™ Resample Image: | Bicubic e ]

every graphic you place online should be set at

The last step is to lighten my image a bit.

After all, remember this is a background, not
a featured piece of the page. Switching to levels should clean things up. Try moving the midtone
slider only, either to lighten, or to darken, the image. As you only move this slider, you'll reduce

contrast, either way.



Levels

| — Channel: RGB B —
0% (14 ok )
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F .
( Save.. )
e J

¢ - C Options... 3
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What's next? We need to settle on a color for our static color, and doing a sample with the

eyedropper will help us out. In the options bar for the eye-dropper, I want the 5x5 sample, to get

an average “blue” for my background color.
-

¢ Photoshop File Edit Image

#

Sample Size:
I

by 3 Average

|

o Y Y Sby 5 fdwverage

?

Then, using the Adobe color picker, I can see the hexadecimal value for this color:

r =]

Color Picker |
Select foreground color: m

O Cancel

O custom
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"1 Only Web Colors

While choosing web-safe colors is always a good idea, in this case, I didn't have a good match, and
decided to live dangerously. As more of us use computers with 16-bit and 24-bit color, using web-
safe colors becomes less pertinent. In fact, some have suggested using a new web-safe assortment
that contains a few thousand “safe” colors. Pantone has an article of interest on the subject:

(http://www.pantone.com/products/products.asp?idArticle=211&idArea=13).




Both GIF and PNG offer us transparency, a requirement in this project. Because many copies of
IE for Windows do not handle PNG properly, I am going to use GIF. PNG, however, is the
superior format, and as more users upgrade their browsers, this will be great news for those of us
wanting 16-bit color plus transparency. In Photoshop, choose Image > Mode >Index. In the
dialog that appears, make your choices for colors and your matte color. If you used the eyedropper,
simply select “foreground” and make sure “Transparency” is selected.

i Indexed Color i

Palette: Local (Selective) T]

ok )

Colors: |36 ek

Forced: None = ¥ Preview
E‘1"I'ralnsp=alrer1t:\-r

Options

Matte: Foreground Color _:]

Dither: = Diffusion |3
Amount: |75 *

" | Preserve Exact Colors

36 colors worked out great for this photograph. With Preview turned on, you can test, and as a

rule, the fewer colors, the smaller your file size. Save the image as a GIF file.

Back in Dreamweaver, I've begun a new web page, and have started to define my CSS. The settings
I chose for the background reflect my design idea: I want my picture positioned in the bottom-
right-hand side of the web page, and I do not want it to scroll. This is possible with CSS using the

following options. Notice I used the hexadecimal color value from the Adobe color picker, in

Photoshop:
r S ~ ]
CSS Style definition for body
Category Background
Type
Background Background Color: [ | [#ccahe?
Block
Box Background Image: file:///Cyclops/Users fadmir: @ [ Browse... )
Border
List Repeat; no-repeat
Positioni —_—
[i:ar:gil:;:g Attachment:  fixed @

Haorizontal Position:  right @ B

Wertical Position: bottom @

Help ) [ Apply ) ([ Cancel -f oK )




Use Dreamweaver to preview your page, once YOLI’I‘C gOt some CSS defined, in your favorite

browser:

B é Dreamweaver BFIEN Edit  View Insert Modify Text Commands Si

New... BN | N |
£
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=
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B Save All (8859-1"7>
Revert D XHTML 1.8 Strict//EN"
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I:D | Print Code... H®P
D‘ Import > . . )
-~ | Export > iontent="text/html; charset=i:
~——n Convert >
Preview in Browser » Internet Explorer
Debug in Browser Safari.app Fiz | A
Check Page »

Edit Browser List...

Design Notes...
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And the result?

:rﬁ 068 My New CS5 Document

John's Web Page

This is my first paragraph, where evidently I'll tell you about my interests.

i L r—
2, ‘l
e, "

Display a menu v
The fun part about viewing this is changing the size of the window! I always obediently stay at the

bottom-right of the page! Since my image is light colored, and low-contrast, even text is readable on

top of my handsome photograph.

To give you a more practical example of this same technique at work, visit the Goochland County

Schools homepage. In a standards-compliant browser, you should see something like the following:



Goochland County Public Schools Homepage —
)
S\ )

N\ (Wi

oochland
COUNTY PUBLIC SCHOOLS

Notice how the

background interacts with
the table beneath. The

image is tacked at the top-

———...
Ieft of the Pagel and blends About Goochland Technology School Board Contacts Employment QOur Schools
at the I'lght into the A Community with Quality Education
back round COlOI‘ a Ii ht On December 9, the Coochland County School Board adopted a Preliminary FY U
g ’ g 2004-05 Budget. Learn more about the details regarding this budget being
presented to county administrators.
graY’ Becau‘se the tltle Of Dr. Morgan recently submitted an article to the editors of our local papers
regarding the state's role of funding public education. Read Dr. Morgan's article
: : online, and become involved!
the page is a GIF with
Goochland Achieves! Full accreditation for our schools is based on this past-year's
. ﬂ SOL scores. We're doing a great job, and innovating too. Long recognized as a
transparency, 1t can rloat leader in educational hnology, we offer b dl pp ities for students
to learn in ways that could only be described as “high-tech.” %Nws
over the lmage When the Explore what we have to offer! Stay informed with this year-long calendar. Dr. Morgan writes about the state's diminished
role in funding K-12 education.
page is resized. Goochland, a Great Location :::tus for lunch? Check out the January lunch
Coochland is a special, picturesque location that is home to history, expansion, Visit our school calendar, online. (-
and convenience to metro-Richmend. Poised alongside the James River to the i3
O - v
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If you really want to have fun with backgrounds, keep in mind you can also apply background

images and colors to just about any element in your page with CSS, including tables, paragraphs,

and <DIV>s.

Eric Meyer (the CSS guru mentioned above), has come up with a cool way to use CSS and the way

it handles background images. I have adopted his technique called Complex Spiral

(http://www.meyerweb.com/eric/css/edge/complexspiral/demo.html), and used it for some pages

our teachers maintain.

YOO Mr. Smith’s Website =
@ @ P hutp:  /www.glnd.k 12.va.us/schools/gms/teachers/rsmith/ =(Q- Google |
M
f ’
mr. smith’s
learning portal
Fractions Powerpoint
Quick review of fractions
Met
Fsmith at 06:05 PM on December 14, 2003
What's up?
Wassup? My name is Cody Pierce. I'm 13 years old and | am in the 6th grade.
My school Is Goochland Middle School. | have no brothers, and | have 3 sisters. My favorite things to do
are to talk to my friends on the phone, play games, and play with my dog Tyson.
Postad by Fomith at 05541 PM on December 14, 2003
Amanda Sinms
(yem
o iomt, :
P Fraction's Guide
A | Use the Fraction's Guide to fill in your worksheets.
Goniaet
Corlez Plroa:
important Ino
Krista Wooddl
3 by Rodn
Math € - V
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While web standards evangelists have moved on to pressing XHTML and CSS to their limits with
great success (Jeffrey Zeldman is one such example, and maintains a great site at

http://www.zeldman.com/), some of us, used to Photoshop’s power, prefer to design a page using

Photoshop. This final example will layout a page which will then be sliced using Image Ready.
Once sliced, you can export your creation using <TABLE>s to hold all the slices together, or, use
CSS and its ability to position-by-pixel, to create a standards-compliant page. It might not have the
usability and accessibility of some sites, but knowing how to massage the code and play on the

strengths of your design are all part of the web design experience.

First, open a new Photoshop document. For the size, choose something larger than you'll need. I
usually choose something like 1200 pixels wide by maybe 800 down with a white background. I
can't tell you how to design (there are complete books and college courses for this), but I will give
you a few hints:

* Make use of the guides and/or the grid in Photoshop

*  Always have your rulers handy (Command/Control- R)

* Turn on the Snap-to-Grid or Guides function—it helps in positioning guides, and moving
layers around

*  Use the Knife/Slice tool to divide up your web page into compartments. This helps in
image-loading time

*  Optimize each slice for file type, quality, colors, etc.

* Turn on the options in the Output Settings |
Output Settings that contribute Settings: (Custom B ok )
to easy conversion to XHTML =T B —_—

. . i
(in the example, opposite, I'd - —
uncheck “Include Zero Tags Case:/ body B _
. . . = Next
Margins...” because this should Autribute Case:|_rowspan )
be done in CSS, not in HTML) Tiatere: I ) i
Line Endings: Mac ﬂ Save..
After switching to ImageReady, you can Coding
@ Include Comments
add effects such as JavaScript roll-overs to ¥ Always Quote Attributes
W Always Add Alt Attribute
your design. Remember one basic rule, ¥ Close All Tags

lInclude GoLive 5 {or Earlier) Code

however, that simplicity should be a ™ include Zero Margins on Body Tag

guiding force in your design decisions. As
you add more script and effects, the file

sizes of both your code and of the required graphics increases.

After some designing, I came up with the following design for a new layout dedicated to training.
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In this close-up, notice how Slice 05 has been switched from Image to Text. This provides me with
a table cell, or a CSS-defined <DIV> that I can add content to in my page, once I've switched over

to Dreamweaver.
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Finally, after the start of some editing, I preview the page in my browser.
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The virtues of using Web Standards, which include, beyond CSS and XHTML, EMCA-
compliant JavaScript and the document object model (DOM), are well-evangelized in the book
entitled Designing with Web Standards by Jeffrey Zeldman (New Riders). Creating sites that adhere
to standards offer, many times:

* backward compatibility with older browsers

* forward compatibility with emerging browsing technologies

* accessibility to those with disabilities and those using non-traditional browsers

* faster download times without bloated code, full of presentational markup

Lastly, the time for using web standards is “now.” To quote Zeldman: “The ability to separate
structure from presentation and behavior is the cornerstone of this new design approach. It is the
way all sites will be designed in the future (unless they are Flash-only sites), and it is already being
used on hard-core, forward-compatible sites...” (page 58—Designing with Web Standards, 2003 New
Riders Publishing). Thankfully, two of the vendors currently trying to best-align themselves for
this new approach are Adobe and Macromedia, creators of Photoshop and Dreamweaver,

respectively.

As a source of parting inspiration, I might suggest perusing the CSS Zen Garden

(http://www.csszengarden.com/), which highlights just what is possible using the tools we've seen

here, and a new approach to designing with web standards at heart.

January 9, 2004



